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About CDP 

Hugh Crocker and Robert Charlebois established Crocker Data Processing Pty Ltd (CDP) in 1983 
for the purpose of developing software and providing petrophysical services for the oil exploration 
and production industry, specifically in well log data interpretation. Both Hugh and Robert are 
internationally recognised experts in the field of petrophysics.  

Today we are the developer and primary user support for the Petrolog and Datalogger software 
suites as well as providing Log Data Management, Petrophysical and Imagelog Analysis services 
both in Australia and worldwide.  

Our headquarters are located in Perth, Australia and we currently employ 4 Petrophysicists and 6 
Software Developers. We also have an organization of licensed third party bureaus in Australia, 
Malaysia, Indonesia, Canada, Pakistan, North Africa and Oman. 

Software and Services 

CDP offers an extensive range of Petrophysical and related services to the oil & gas industry. Our 
Petrophysicists and Technical Assistants have a strong background of field experience and each 
project or job is treated on an individual basis. A summary of the services provided include: 

• Real Time Data Acquisition software development (Datalogger)  

• Log Data Media & Format Conversions 

• Log Data Digitisation 

• Data Quality Assurance, Management and Archiving 

• Data Editing and Composites 

• Log Analysis and advanced Petrophysics 

• Petrophysical Field Studies and Cross-Sections 

• Synthetic Seismograms 

• Imagelog Processing and Image based Petrophysics 

• Sonic Waveform Processing 

• Cased Hole Log Analysis 

• Training Courses in the above disciplines 

Both the services that we provide and our client requirements directly drive the Petrolog software 
development. Some examples of client driven functionality include: 

• Recomputed logs (DTC, DTS & RHOB) generated from the log analysis results to provide 
a clean set of log data for Geophysical processing. 

• Rock Strength Module (including Mechanical Properties, UCS, Wear Indices, etc) for a 
Bit Manufacturer. 

Our People 

The CDP team consists of the following personnel: 

Management and Petrophysical Services 

• Robert Charlebois: Petrophysicist (Managing Director) 

• Michael Isherwood: Petrophysicist/Geophysicist (Services Manager) 

• Scott Cole: Petrophysicist/Reservoir Engineer (Software Development Manager) 



Petrolog 10.5.2: Getting Started Guide 

2 

• Kevin Fernandes: Junior Petrophysicist/Technical Assistant 

Software Development 

• Basil Furdas: Senior Software Engineer, Programmer 

• Phi Nguyen: Programmer & Graphics Specialist 

• Arthur Goh: Programmer & IT support 

• Libor Masek: Programmer 

• James Hoeneveld: Programmer 

• Edwin Wong: Consultant Programmer 

Administration and Support 

• Pia-Anna Charlebois: Accounting/Technical Assistant 

• Sylvia Mondello: Office Support 

Contact Us 

The main CDP office is located in Perth, Western Australia. 

Suite 1, Petroleum House 
12 Brodie Hall Drive 
Bentley, Technology Park 
Perth, Western Australia 6102 

Phone: +61 8 9470 5004 
Fax: +61 8 9470 5003 
Email: info@petrolog.net 
Web: www.petrolog.net 
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About Petrolog 

Petrolog is a specialised Log Data Management, Petrophysical and Imagelog Analysis software 
platform that performs many of the tasks associated with the management and evaluation of well 
log data. Petrolog is at the forefront of the industry by keeping abreast of new technology and the 

development of new advanced interpretation models. 

Petrolog has been developed with the close interaction of its many users and their feedback. 
Crocker Data Processing welcomes any comments which will contribute to the future 
development of Petrolog to make it more powerful and intuitive for its users. 

History 

The original version of Petrolog was first released for the oil industry on mainframe (VAX, 
PRIME) in 1982. Since then it has been ported to all popular operating systems (UNIX, Linux, 
DOS, Windows 95/98/2000/XP). In 2006, the software was ported to the Microsoft Windows .NET 
framework using the latest C# language. 

For new users and users migrating from the old Petrolog software, a set of Tutorials have been 
created to give an overview of a complete well processing workflow. This is in addition to a 
detailed set of context sensitive help files (accessed via the F1 key).  

For example, a detailed overview of the CPX Petrophysical Analysis technique (CPX Analysis: 
Step-by-step overview) is available to guide the user through the sequence of steps required to 
take to obtain a full petrophysical well analysis. 

Software Module Overview 

Basic Module 

This module is required for the basic Petrolog functionality and to support any additional 

modules. It includes the following items: 

• Import/Export Data: Petrolog can import and export data from several industry standards 
including LIS, LAS/LBS 2.0, LAS 3.0, ASCII and SEG-Y into our proprietary binary format 
file. This module also has an extensive set of tools for verification and reading from a 
variety of legacy tape media and formats (including 9-track, DAT and exabyte tape 
media). 

• Petrolog Desktop: The Petrolog Desktop contains the various controls to create and 
manage a field or well based project including the Explorer, Log Listing, Workflow 
Explorer, Preferences and Calculator. 

• Petrolog Mapview: Mapping Quality Control tool including well paths, contouring, bubble 
maps and interactive well selection 

• Discrete Data Management This is a set of user definable tables to allow management of 
well header information, any type of non-continuous well data (e.g. directional surveys, 
core, DST, formation tests, etc) and Strata type data (e.g. Formation Tops). 

• Continuous Log Management: This is an extensive set of tools to manage, edit and 
perform simple processing of continuous well log data. The log editing functions include 
both tabular and graphical methods of merging, editing and TVD/TST processing. 

• User Algorithms: A powerful and flexible scripting language to create user defined 
functions and processes. 
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• Graphics: Includes plots for all log types, histograms, cross-plots (both 2D and 3D) and 
stereographic projections. All graphics can be sent to all windows supported printers and 
plotters and to a variety of graphical formats including EMF, PDF, JPG etc. 

• Montage Editor: A graphics editor that allows users to edit and build A0 or larger 
presentations including saved plots, cross-plots, histograms and any other type of images 
in almost any graphical format. 

• Data Mining: Includes a variety of data analysis and reporting tools. 

• Petrolog Tools: A set of tools including a fully featured "petrophysics" calculator, utilities 
to convert existing Petrolog V9 data and plot formats to V10, graphics conversion utilities 
and the Petrolog evaluation request utility. 

Log Analysis 

This module provides an extensive variety of Petrophysical Log Analysis functionality including 
the following items: 

• "Quicklook" Analysis: A set of User Algorithms to enable a user to manually perform a 
basic "step-by-step" log analysis to generate Vclay, Porosity and Water Saturation in 
sequence. 

• CPX" Integrated Log Analysis: A fully integrated crossplot based analysis system utilising 
either the Complex Lithology, Sand-Silt-Shale (SSS) or Two Water (TWA) models. This 
technique has been developed and refined by CDP over the last 20 years and is being 
used successfully for a huge range of clastic and carbonate environments from all over 
the world. The CPX integrated analysis includes the following features and output logs: 

• Environmental Corrections for all standard logging tools from the major Wireline 
& LWD Service Companies (Schlumberger, Halliburton, BHI, 
Weatherford/Precision/Reeves, Tucker, Probe). The log analysis processing will 
handle any mixture of different logging tools in the same well. 

• Vclay determinations from 9 clay indicators, with non-linear transforms and 
various final Vclay indicator selection options. 

• Ability to use any combination of external logs (Vclay, PHIT, PHIE) and input 
parameters (a, m, n, Rw etc) 

• Gas and shale corrected Effective and Total Porosity automatically generated 
from best available porosity logs. 

• Wide range of Saturation Equations based on both SWE (Indonesia, etc) and 
SWT (Waxman-Smits, etc) methodologies.  

• Dual clay resistivity model and glauconite options available with all models. 

• Lithology and permeability determination available using various techniques. 

• Uncertainty estimation of the key petrophysical results. 

• Generation of a recomputed DTC, DTS and RHOB based on the results of the 
log analysis. Either the original logs or these results are used to compute and 
detailed set of Rock Mechanics and Rock Strength logs. 

• Additional processing available for various auxiliary logging tools and techniques 
including NMR, EPT and CBM (Coal Bed Methane) using the results of the CPX 
Integrated Analysis. 

• "CPX" Multi-well Processing: Unlimited number of wells can be processed utilising strata 
selections and a single well reference CPX analysis. 

• Hydrocarbon Volume Reporting: Includes full single & multiwell lumping, P10/P50/P90 
petrophysical and cutoff uncertainty statistics,cutoff sensitivity module. 

• Neural Network Analysis: Use of a Self Organising Map technique to estimate missing 
logs, permeabilities or facies based on a representative training data set. 
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DLIS 

• The Import/Export DLIS module is required to Import or Export DLIS log data. 

Multimin 

• A Multimin Probabilistic Analysis module to complement the existing "CPX" and 
"Quicklook" deterministic approaches. This will allow the user to fully define and utilise 
any mineral, mineral property, constraint and crossplot to determine your minerals and 
lithology volumes probabilistically. 

• An initial release is available in the Petrolog 10.5 which includes fully user definable 
minerals, properties, crossplots and a fully interactive crossplot based interface (similar to 
the CPX functionality). Further updates to the available constraints and processing 
options will progressively be introduced during 10.5 software upgrades. 

Digitise 

• The Board Digitisation module allows digitisation of logs directly from film or prints using 
a digitising board. 

Cased Hole Analysis 

• The Cased Hole Analysis (or "Prodlog") module is used to process Sigma and Carbon-
Oxygen logs in conjunction with the Open Hole logs to determine changes in saturation 
over time. 

Geophysics 

• The Synthetic Seismogram module includes the capability to read/write SEG-Y files, 
perform check shot corrections and compute synthetic seismograms using user defined 
wavelet convolution. 

Cross-Sections 

• The Cross Section module is used to generate interactive 2D multi-well cross sections. 
The 10.5 release includes full directional/horizontal well paths, user defined well plot 
templates, interwell and interactive surfaces, faults, etc. 

Imagelog 

• The Imagelog Analysis module supports a wide range of Dipmeter and Imaging tools 
(FMS, FMI, EMI, HMI, STAR, Sonic images, BHTV, 3, 4 or 6 arm dipmeter tools, RAB, 
ADN tools, Core photos, etc.). This module includes the following features: 

• Imagelog graphics including Tadpoles/Sinusoids, Stereonets, Stick Plots, 
Azimuth Roses and Breakout Plots 

• Imagelog processing including accelerometer, Emex, speed corrections, button 
and pad depth shifts, arm swing, tool tilt, etc. 

• Advanced Dip Editor and Autodip Processing 

• Fracture Frequency and Width Analysis 

• Advanced Stereonets 
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Image Petrophysics 

• The Image Petrophysics module includes the computation of Azimuthal RT, Vclay, 
Porosity, Grain Size Sorting and Permeability distributions from Images. Includes 
graphical zoning, multi-linear and Sw resistivity compensation. 

Sonic Waveform  

• A Sonic Waveform Analysis module to interactively pre-process and determine 
Compressional, Shear (monopole & dipole) and Stonely DT's for all available Wireline 
and LWD digital sonic tools. Includes a zone based control file, AGC, frequency filtering 
and flexural dispersion corrections. The 10.5.1 release includes a dipole shear anisotropy 
processing module. 

Petrolog Roadmap 

Following the Petrolog 10.0 commercial release in June 2006, an extensive array of 
enhancements and new features have being implemented for Petrolog, with further details 
available in the Release Notes. The ongoing release schedule is progressing as follows: 

Petrolog 10.5 (March 2008) 

Petrolog 10.5 includes an extensive array of improved functionality for many of the current 
modules.  

• Environment: Improved the preferred units system, hybrid units (e.g. Canadian) now 
applies to all graphics and CPX functionality. 

• Import/Export: Merged the LAS, ASCII and Petrolog V9 Import and Export functionality 
into a single dialog, with extensive workflow efficiency enhancements and options added. 

• Petrolog Explorer: Added a well filter using file name, wellheader field and log 
availability search criteria. 

• Continuous Data: Logdata file read/write access upgraded to allow only one write 
process to access the logdata file 

• Continuous Data: Majority of dialogs & processing now "modeless" allowing continued 
interactivity during processing. 

• Plots: Can now display any log from multiple files/wells on same plot, plus many other 
enhancements including "scroll locking" between plots. 

• Plots: Improved stability printing very large graphics file outputs to EMF and XPS formats 
and downscaling of graphics images to display/print resolutions. 

• Histograms: Can be used to generate Normalised Log outputs and statistics reports 
from data/intervals displayed on Histogram. 

• Crossplots: Extensive improvements including improved multiwell display, ghost 
background mode and additional display options. 

• Petrophysics: Multiwell CPX crossplots now fully operational, with intuitive formation 
selection logic when changing between wells. 

• Petrophysics: Extensive updates to the Hydrocarbon Volume Reporting module 
including a new cutoff sensitivity analysis module. 

• Cross-Section: New module with full directional well paths and fully interactive objects 
(wells, strata, faults, etc). 

• Mapview: Now displays well directional paths, plus many additional display options. 

• Digital Sonic Processing: Added AGC corrections, Flexural Dispersion, Transmitter 
Array and Sonic Anisotropy processing to module, plus additional tool definitions. 
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• Datalogger: Added auto-remarks plus additional depth encoder support to the FET 

datalogger software. 

Petrolog 10.6 (Q3 2008) 

Petrolog 10.6 will include a progressive revamping of the Petrolog data models to add features 
including full group functionality for continuous logs and a central "control panel" for to handle all 
well/depth interval/strata/log/unit selection. It will also include the full implementation of various 
processing modules that are still in final development (Digital Sonic Processing, Multimin, 
Carbon/Oxygen Processing, Cross-Section, etc). 

• Environment: Upgrade to the .NET 3.5 framework to add native 3D libraries and other 
new functionality. 

• Environment: Updates to the Petrolog library to fully support third party application 
development via a Software Development Kit. 

• Petrolog Control Panel: Initial upgrade of the various control panel components 
(Explorer, Strata and Log Listing displays) to eventually display and manage all well, 
strata, log and unit interactions for all of the Petrolog application modules. The following 
changes will be incrementally added to Petrolog 10.6 in preparation for the full Control 
Panel implementation in Petrolog 11.0: 

• Continuous Logs: Add group (i.e. set) functionality, improvements to logheader 
attributes, multiwell functionality and statistics management. 

• Discrete Data: Logical merge with continuous data (e.g. display in Log Listing, 
drag and drop, unit management, etc)  

• Strata: Shift Strata functionality (default and well) into Discrete Data to improve 
ease of use and flexibility. 

• Units: Control panel will automatically handle all unit conversions as logs are 
passed/received to/from applications. 

• Import/Export: Merge all Import/Export modules into a single interface, with all options 
available for every file format. 

• Process Management: Add a process monitor to support native multithreading, process 
queueing and status display for all Petrolog applications. 

• Petrophysics: Continuing improvements to CPX functionality including full log 
nomalisation, triaxial resistivity, additional NMR processing, etc. 

• Cased Hole Analysis: Full implementation and CPX integration of Carbon-Oxygen 
Processing (RST, PGST) functionality. 

• Multimin Processing: Full implementation including improved constraints, petrophysics 
integration and processing reporting. 

• Cross-Section & Mapview: Further enhancements including background graphics and 
GIS map interactivity. 

• Imagelog: Addition of a "fast" display mode to optimise Imagelog dip picking throughput. 

Petrolog V11 (Q2 2009) 

Petrolog 11.0 will see a system wide upgrade of all of the Petrolog functionality as follows: 

• Petrolog Control Panel: Full implementation of the Petrolog Control Panel, and upgrade 
of every Petrolog application to access all required processing input/output well, intervals, 
logs and units via the control panel. Every application will natively support single and 
multiwell processing. 

• Help Files: These will be fully updated as each application is standardised to utilised the 
Control Panel. 
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• Environment: Full project based networked multi-user and security functionality via the 
Control Panel. 

• Environment: Full multithreading of all processes, with a process management console 
available. 

• Discrete Data: Full implementation of WITSML 1.3.1 Well Header, Discrete Well Data 
and Units standards. 

• User Algorithms:  Major upgrade to User Algorithm functionality including access to the 
Petrolog library routines. 

• Formation Test Module: Fully Interactive Formation Pressure Gradient Analysis module. 

• Digital Sonic Processing: Addition of a Stonely Permeability and other Sonic 

Petrophysical processing. 

Petrolog V12+ (proposed future module development based on client 
demand) 

• Graphical Workflow Manager: Flowchart style tool to build a process flow using User 
Algorithms with full access to all Petrolog libraries 

• WITSML client: Real time data acquisition client module. 

• Inter-operability Modules: As required for Openspirit, Petrel, Openworks, etc 

• Crossplots: Module to create multiple input multivariate crossplot analysis. 

• Borehole Geomechanics: Mechanical Earth Modelling, Shear Anisotropy and 
Permeability, Stress & Breakout Analysis module 

• Core Evaluation: Advanced Core Analysis processing 

• Borehole Geophysics: Advanced Synthetics, Fluid Substitutions, VSP, Seismic 
Modelling (AVO, etc) 

• Monte-Carlo Uncertainty: Full Monte-Carlo Uncertainty processing. 

• Electrofacies Processing: Advanced crossplot cluster based Electrofacies identification. 
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Getting Started 

Getting Started Overview 

Welcome to Petrolog! 

This section provides an overview of installing and executing Petrolog. The following key topics 

are reviewed in this section: 

• System Requirements: Petrolog Hardware and Software requirements and 
recommendations. 

• Installing Petrolog: Instructions to install Petrolog. 

• Petrolog Network Installation: Additional Instructions to install Petrolog to access a 
networked multi-user license. 

• Using Petrolog Help: Accessing the Petrolog Help system. 

• Evaluation License: Requesting and registering a 60 day full evaluation license for 
Petrolog. 

• Filename Conventions: Standard data file and Petrolog naming conventions. 

• First Time Users: Initial instructions to assist new users in configuring Petrolog 

There is also a detailed listing of all New Features, Enhancements and Defect Fixes for this 
release in the Petrolog Release Notes help topic 
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System Requirements 

Hardware Requirements 

The hardware requirements will vary according to the amount and type of processing the user is 
required to perform. 

Minimal PC specification (suitable for loading and editing of standard resolution log data): 

• CPU: Intel 2.0 GHz (or AMD equivalent) 

• Hard disk (installation only): Approximately 200 MB (includes requirements for the 
.NET 2.0 framework) 

• Hard disk (well  processing): Recommend a minimum of 10 GB free space available for 
single well, standard log data processing. 

• RAM: 1GB RAM 

• Monitor: 17" or larger 

Recommended PC specification (suitable for all processing including Digital Sonic and 
Imagelog Processing): 

• CPU: Intel 3.2 GHz or faster (or 64 Bit AMD 4200+), with dual core preferred. 

• Hard Disk (installation only): Approximately 200 MB (includes requirements for the 
.NET 1.1 framework) 

• Hard disk (well processing): Recommend 50 GB free space available (up to 400 GB 
may be required if large Imagelog files need to be processed)  

• RAM: 2 GB DDR2 RAM 

• Video Card: Any fast card with 256 MB DDR3 VRAM 

• Monitors: Two x 20"+ high resolution Flat Panel TFT displays or larger 

Petrolog creates temporary files during some data manipulation tasks and may require virtual 
memory on the hard drive depending on the number of files opened and your PC memory. A 
good guide is to have at least enough empty space on your drive to mirror the size of the data 
files you will have open at any time. 

For a user who wishes to perform heavy processing the following hardware specifications may 
further improve Petrolog performance. 

• Use a 64-bit CPU and with the Windows XP 64 operating system. 

• Changing the hard disk configuration to use RAID 0 or RAID 5 with 2 or more disks. 

Petrolog may run at lower specification than those noted under the minimal/basic requirements 
however the performance may be degraded. 

Printers 

Petrolog generates EMF or EMF+ files and uses the Windows drivers supplied by the 
manufacturers to generate the hardcopy output. A problem that often occurs is that many 
Windows printer drivers only support a limited length plot.  
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• Printer: Any printer or plotter that supports continuous printing (preferably high volume 
and a minimum A2 paper size). Some recommended printers/plotters include: 

• Epson: Stylus 3000 (now obsolete), Stylus pro 4000 printers. The Epson Stylus 
Pro drivers currently allow unlimited plot lengths. 

• HP: Designjet 1000 or any other high volume Design jet plotter. The default HP 
Designjet plotter drivers will paginate plots longer than 200 inches. The solution 
is to download an HP RTL driver from the HP web site. The driver download 
program name is PL532en.exe from www.hp.com and will allow unlimited plot 
lengths on most HP Designjet plotters today. 

Digitising Boards 

• Digitizing Boards: Petrolog supports an extensive range of Digitizing Boards, with the 
full list available in the Digitisers Preferences.  Due to industry consolidation, the major 
remaining digitizer manufacturer is GTCO Calcomp (see 
www.gtcocalcomp.com/digitizers/ for more details). We recommend either the 
Summagrid or Super L range of digitisers if a board needs to be purchased. 

Operating System Requirements 

The Microsoft .NET framework and Petrolog are supported on the following platforms. 

• Microsoft® Windows® 2000 Professional 

• Microsoft® Windows® XP Home Edition 

• Microsoft® Windows® XP Professional (Recommended) 

• Microsoft® Windows® XP Professional (64 bit) (note that XP SP2 must also be installed) 

• Microsoft® Vista® (Recommended) 

• Microsoft® Vista® (64 bit) 

• Microsoft® Windows® Server 2003 family (Not recommended, some users have reported 
crashes that can not be reproduced on non Server versions of Windows and we have 
found that the USB Network Bitlock can't be read from a local port on the 2003 Server 
PC). 

Software Requirements 

In order to install Petrolog the following installation files are required (available for download from 

our website at www.petrolog.net): 

• dotnetfx.exe: The Microsoft .NET 2.0 distributables package which must be installed on 
the users PC. For convenience, a copy is available from our website or it can be 
downloaded from Microsoft. 

• Petrolog10.5_setup.exe: Petrolog installation file. 

• Petrolog10.5_Getting_Started_Guide.pdf: System requirements and Installation 
Instructions (these notes). 

• Sentinel Installer 7.4.0.exe: Sentinel/Bitlock driver for Win 32 systems (required for 

licensing control with sentinel bitlock, not required for evaluation mode). 

The following support files are also available for download:  
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• Petrolog10.5_Tutorials_Examples.zip: Set of example wells and data set as used in the 
Petrolog Tutorials and during our formal Training Schools. Highly recommended for a 
new user. 

• Petrolog10.5_Help.pdf: The current set of Petrolog Help files in printable pdf format. 
Note that the Petrolog.chm help file is also installed into the c:\Program 
Files\Petrolog\Documentation\ folder during installation. 

• Sentinel Installer 7.2.2 (64-bit).exe: Sentinel/Bitlock driver for Win 64 systems. 

• Metaviewer10.5_setup.exe: Freely distributable tool created by CDP for viewing .emf 
graphics meta files. Not required if Petrolog is installed, but can be installed on other 
PC's to view Petrolog generated emf files. 

Additional/Optional Software 

Additional software packages which complement Petrolog and the user may find useful include: 

• VRML plug-in for your web browser: Available if you wish to view the Petrolog 3D 
cross plots. A VRML plug-in for Microsoft Internet Explorer has been included and can be 
found in c:\Program Files\Petrolog\Installers\. 

• Microsoft Office: The Petrolog Discrete Data module supports full cut and paste 
functionality between Petrolog and Excel spreadsheets. It is also recommended that 
Excel is used to generate the formatted tables of well data generated for Composite Well 
plots.  

• XML Editor: Petrolog uses the standard windows notepad.exe by default. Petrolog 
uses xml format for all well header, plot and preferences files. These files can be edited 
directly by knowledgeable users.  

• Text Editor: Petrolog uses the standard windows notepad.exe by default. The user can 
change the default to use a more advanced text editor such as textpad or wordpad if 
installed on the PC. 

• XPS writer/viewer: XPS (XML Paper Specification) is a page description language 
developed by Microsoft as a successor to EMF (and as a alternative to PDF). An XPS 
printer driver and viewer is included in Windows Vista and is available for free download 
from Microsoft for Windows Server 2003 and XP. The major advantage for typical log plot 
outputs is the removal of the 200 inch page limit inherent in PDF and we have used and 
can recommend the use of XPS. 

• PDF writer: If you require PDF format documents. Either Adobe Acrobat can be 
purchased or various freeware options are available. The PDF writer software that we 
have used successfully include the following: 

• Adobe Acrobat: The industry standard that we are using on our XP machines. 
However, it needs to be purchased and there are freeware PDF writers that work 
as well or better. For Windows Vista users, Acrobat 8.0 is required.  

• PDFCreator: The best freeware PDF writer available that has handled all of the 
complicated plots that we have generated. In addition, version 9.5 and later also 
works under Windows Vista. 

• CutePDF: Very good, has some minor issues with complex prints. Works well 
with both Windows XP and Vista. Our main tip for using CutePDF is that if some 
graphics seem to be missing from the output pdf file, reduce the default Print 
Quality setting from 600 dpi to 300 dpi. 
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Installing Petrolog 

Please first refer to the System Requirements for further information on Hardware and Software 
requirements. Further instructions on setting up a network license can be found in the Multi-User 
Bitlock Installation help notes. 

First time Installation 

Petrolog install files can be downloaded from the downloads section at our website at 

http://www.petrolog.net.  If required, an installation disk can be sent out upon request. 

1. Log into your PC with Administrator permission. (This may require assistance from your 
IT department if your corporate setup does not give users permission to install software 
with limited user permissions). 

2. If your PC has not had the Microsoft .NET 2.0 distributables installed, double click on the 
dotnetfx.exe to install. 

3. Double click on Petrolog10.5_setup.exe and follow the on-screen instructions to install 
Petrolog. 

4. Double click on Sentinel Installer 7.4.0.exe to install the latest version Sentinel Bitlock 
driver. This driver is not required if you are only evaluating the software. If you have a 64-
bit Windows system, you will need to download the Sentinel Installer 7.2.2 (64-bit).zip file 

insteadl. 

Note: If downloading from our website Petrolog10.5_setup.exe is over 65 Mbyte in size and 
depending on your internet connection may take a while to download.  

Note: You may have a corporate firewall which will prevent you from downloading executables 
from the web. Please either consult with your IT department or contact CDP to arrange an 
alternate delivery method (usually either via FTP or CD) 

CDP Recommendation: Open the Windows Explorer Folder options and set the following: 
 
1) Un-check the "Hide extensions for known file types" option (easier to recognise file types in the 
Petrolog Explorer). 
 
2) Check the "Show hidden files and folders" option (otherwise the default User area (see below) 
may be hidden in Windows Explorer).  
  

Petrolog Installation Locations 

Petrolog uses  two main directories, the Master Area and the User Area. 
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Figure 1: Petrolog Installation Directory Structure 

1) Master Area: The program is installed into "c:\Program Files\Petrolog\" with the original default 
preferences set as read only. A second Master Area "c:\Program Files\Petrolog (Beta)\" is 

created when a Beta version is installed to allow side by side installations on the same PC. 

The following types of files are located in the master defaults directory: 

• Algorithms: Algorithms (text format) supplied with Petrolog are located here (*.alg). 

• Charts: Density-Neutron and Sonic-Neutron crossplot overlays (xml format). CDP can 
add any missing charts on request. 

• Emf: Symbols (and logos) supplied with Petrolog are located here. Each supplied emf 
symbol (*.emf) also has a montage file supplied (*.montage) so that the user can edit and 
create additional symbols easily using the Montage Editor 

• Lithology: Petrolog Lithology patterns (*.gif format) are defined here. These patterns 
are combined with colours in the Petrolog preferences to create lithologies. 

• Plot: Plot templates (xml format) supplied with Petrolog are located here (*.plot). 

• Xlgs: LAS export template files (xml format) supplied with Petrolog are located here 
(*.xlgs) 

• Xml: Petrolog default preferences (xml format) are defined here (*.xml). 
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Figure 2: Petrolog User Area Directory Structure 

 2) User Area: The user area which contains all the user created configuration files ia located 

under the following directories: 

• Windows XP: "c:\Documents and Settings\All Users\Application Data\Petrolog\"  

• Windows Vista: "c:\ProgramData\Petrolog\" 

The User Default directory structure here is a mirror of the Master Default directory with any 
modifications made to the Master items saved into the User area. The following categories of 
user files are created: 

• Algorithms: User Algorithms updated or created by the user are saved here.  

• Emf: Any graphics objects modified or created by the user. Any logo graphics files (emf, 
gif or jpeg) required for Petrolog plots (e.g. company logos, etc) need to be copied into 
this directory. 

• Lithology: Not currently used by Petrolog 

• Plot: Any plot templates modified or created by the user are saved here. 

• Wellfilters: Any saved Petrolog Explorer user filters are saved here. 

• Xlgs: Any LAS export template files modifed or created by the user are saved here. 

• Xml: Any updates to the default Petrolog preferences are written here, and are loaded in 
preference to the original preferences in the Master Area. To restore the Master install 
preferences, simply delete the relevant file here. Expert users can edit these files directly 
with a xml editor if desired. 
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Re-installing or Updating Petrolog 

Remove all previous Petrolog installations as follows: 

1. Go to Control Panel -> Add or Remove Programs.  
2. Click on Petrolog 10.4 (or an earlier version if you have one) and click the Remove 

button. 
3. If there are some user preferences (e.g. Log Names Defaults, Unit Definitions, etc) that 

the user wishes to import to the new version after installation, an Upgrade User 
Preferences tool is available under Petrolog Tools > Upgrade User Preferences once 
the new version has been installed. 

4. Otherwise we strongly recommend that the Petrolog User area is deleted before 
upgrading to the new version of Petrolog. Delete the user area at c:/Documents and 
Settings/Application Data/Petrolog/ or c:/ProgramData/Petrolog 

5. Install the new version of Petrolog (see First Time Installation instructions above) 

Starting Petrolog 

• Insert the supplied Sentinel bitlock (if running a licensed version) into a USB port (the 
older parallel port bitlocks are also compatible with the latest Petrolog) 

• Click on the  icon on the desktop to start Petrolog or select Petrolog from the 
Windows START menu. 

• Click on the F1 key to access the Help Contents and select the Getting Started Topic for 

a Getting Started Overview. 

Note: Petrolog should be run for the first time after installation while still logged on with 
Administrator Permission as some of the configuration files in the Program Files directory are 
updated. After the first time run, the software can be run under a more limited User Account. 

Troubleshooting Petrolog after Installation 

Occasionally, Petrolog fails to start correctly after a new installation, particularly when run under 
a Windows User Account with restricted or unusual settings or the PC has crashed with Petrolog 
opened. Please contact us with any details of the problem. In the meantime, the troubleshooting 
steps that we recommend be followed in these cases are: 

• Ensure that you have the latest version Petrolog available (either the Commercial 
release, or the latest Beta version) from our website 

• Completely uninstall the problem version following the directions listed above, including a 
full deletion of the User area. 

• Uninstall the .NET framework via Control Panel > Add or Remove Program > 
Microsoft .NET framework 2.0. and select Remove. 

• Remove the following directories if they exist: "c:\Documents and Settings\'...current 
user...'\Local Settings\Application Data\Isolated Storage". These directories are created 
by a third party library (Syncfusion) included in Petrolog and has been known to become 
corrupted and preventing Petrolog from starting. 

• Reinstall Petrolog, ensuring that you are logged on in Administrator mode. 

• Run Petrolog again. If still unsuccessful, create a new user account and try running 
Petrolog from there. 

• If still unsuccessful, try installing Petrolog on another PC. This will isolate the problem 

down to a particular machine configuration causing problems. 
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Petrolog Support 

1) Petrolog Help: If you are having problems using Petrolog, you can view the help manual by 

pressing "F1". See Using Petrolog Help for more details 

2) CDP Support: Please either phone or email us at support@petrolog.net directly. Support is 
available during our office hours and all queries will receive a response with a solution or work 
around within one working day. 

3) Problem Reporting: To provide a solution to any problems you are having with Petrolog, we 
need enough information to be able to reproduce the problem here. In your email to CDP, please 
include as much of the following information as possible: 

• The version Petrolog that you are using (obtained by selecting Help > About Petrolog 
from the main menu 

• Any error messages that occur (cut and paste the error message text into your email). 

• The sequence of steps taken to reproduce the error. 

• Any files needed to repeat the process (please do not send large files through email, if 
required an ftp account can be created for large file transfer). The files that need to be 
sent may include: 

• Input Data Files (e.g. LAS, LIS, DLIS, etc) 

• Petrolog Data Files (e.g. .logdata, .wellheader) 

• Petrolog Plot Files if problem occurs with a plot open ( .plot) 
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Multi-User Bitlock Installation 

On the Server PC 

A Network Sentinel bitlock (coloured purple rather than green for a single user Sentinel bitlock) 
needs be inserted on one PC (called the "Server PC" in the following instructions) on the users 
network. 

1. Connect the Multi user bitlock on the desired PC server  

Windows 2003 Server operating system does not allow the driver to locate the Sentinel bitlock if 
the user logs into the Server from another PC. In this case, the Sentinel bitlock must be inserted 
into a different PC on the network and NSP_HOST will need to be set to the PC with the bitlock 

1. Install the Software Sentinel driver (Sentinel Installer 7.4.0.exe) from the installation CD 
or downloaded from our website on the server PC. 

2. On the server PC open a DOS Prompt window and type the command ipconfig and note 
the address of this host computer (you may need to first navigate to your Windows 
system directory such as c:\windows\system32\ to locate the ipconfig.exe file). 

  

4. In this case, the Server PC address is 192.43.189.192  
5. [optional] Copy from the installation CD-ROM the following three Sentinel utility programs 

to the Server PC. These provide useful tools for troubleshooting and monitoring the 
license status between Server and User PCs 

• loadserv.exe  

• spnsrvnt.exe 

• monitor.exe 
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On each User PC 

1. Open a DOS prompt window and type the command "ping ???.???.???.???", where ??? 
is the IP address of the Server PC as determined above. This checks that the Server PC 
is running and accessible from the User PC. 

 

2. Click Control Panel > System. Click the Advanced tab and select the Environment 
Variables button to display the following figure. 
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3. Click New under System Variable and add a New System Variable containing 
"NSP_HOST" and "???.???.???.???" using the Server IP address as determined 
above. This allows the User PC to locate the Server PC and access the Network Sentinel 
bitlock. 

 

4. Reboot the User PC. 

Monitoring the Users 

1. Run the program monitor.exe on the Server PC or on a PC with Petrolog running to 

obtain the following Network Sentinel Bitlock status 
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Checking number of licenses  

2. Run Petrolog 
3. Click File > Preferences > Program Permissions to obtain the following summary. In 

this example, Bitlock 5001 has been found at IP address 192.43.189.196. This 5 user 
Sentinel Bitlock has been limited to a single license which is being used by this instance 
of Petrolog. 
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4. If Petrolog can not find the Network Sentinel bitlock on the network, check that the 
Server PC is on and physically has the bitlock in one of it's USB ports. Also perform the 
ping operation described above to check it is accessible from the User PC. Another 
option to monitor the bitlock status directly is via a web browser. Type in the Server IP 
address followed by ":6002" as follows: 
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5. If the Network Sentinel bitlock is still not available, we have found that the Sentinel 
Protection Service sometimes does not initialise correctly when the bitlock is removed 
and reinserted in the USB port. To restart the Sentinel Protection Service, open the 
Windows Services Dialog under Control Panel > Administrative Tools > Services. 

 

6. Double-click the Sentinel Protection Server Service, then click Stop and then Start to 

re-initialise the Sentinel Service. If this still doesn't work, it's time to give us a call! 
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7. If you start Petrolog, and the maximum number of users has already been reached, the 

following error message is displayed. 
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Using Petrolog Help 

Once Petrolog is running the help system can be accessed by the following methods: 

• From the main menu: Help > Contents, Help > Index or Help > Search 

• Pressing the "F1" key for context sensitive help. 

Note: Petrolog uses the standard Microsoft compiled html ("chm") help file format which can be 
viewed from outside Petrolog. The help file is located at c:\Program 
Files\Petrolog\Documentation\Petrolog.chm. 

This file can be run independently from Petrolog and be used for training purposes. 

 

Figure 1: Help File Example (Vclay from Density-Neutron topic) 

The Windows Help Display consists of the following elements: 

• Content Panel: The content list is designed to closely match the software main menu 
and the order in which a user would work through a particular function of the software. 
The help manual is closely linked to the section of the software that is being used. 

• Index Tab: Allow users to access the manual using key sections of the manual. 
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• Search Tab: Used to search for specific topics or keywords .For example type 
"Simandoux" to find the Saturation equations containing the Simandoux equation. 

• Glossary Tab:  Gives a list of short names and their meanings. For example XML = 
 eXtensible Markup Language.  
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Evaluation License 

In order to evaluate Petrolog without a full license, a 60 day evaluation license is available. With 
the evaluation license, the full functionality of the software (with ALL optional modules activated) 
is available with the following restrictions: 

• Plot Graphics include an "Evaluation only" watermark. 

• Exporting data is disallowed. 

If you have an existing Petrolog license and you wish to evaluate some additional modules not 
included in your license, please feel free to request an evaluation license. If you start your 
existing version with the bitlock removed from your PC, the software will start in Evaluation mode. 

To return to your licensed version, exit the program, re-insert the bitlock and start Petrolog again. 

Evaluation Request and Registration 

To request an evaluation license you will need to use the following dialog to create a unique 
hardware key (generated from the hard drive volume number). To obtain the unique hardware the 
user must first install Petrolog, as outlined in Installing Petrolog, then go to the menu Petrolog 
Tools > Petrolog Evaluation. 

 

Figure 1: Petrolog Evaluation Request and Registration 

The hardware key in the request section can then be sent to Crocker Data Processing via email 
with the subject "Evaluation Request". 

Once the evaluation password has been received, the evaluation version can be registered. Note 
that the registration is specific to the request Hardware Key sent to us, so can only be used on 
the same PC that generated the request. 

Once the registration has been entered, exit and restart Petrolog to begin your evaluation.  
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Also note that the evaluation license will remain valid if you install any Petrolog upgrades during 
the evaluation period. Please check our website at www.petrolog.net on a regular basis for the 
latest news and upgrades. 
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Filename Conventions 

We can split the associated Petrolog files into three groups: 

Import/Export Format Files 

These can be any external file that are either POSC compliant or any other format file to store 
well log data information or reports. These files need to be converted to the Petrolog internal 
format files for processing and include: 

• ASCII: File or text files containing logs in columns or text remarks. Files with the .txt 
extension are ASCII format files. ASCII files written using different operating system can 
be different depending on how the line is terminated. (UNIX, DOS and Apple ASCII files 
all have different end of line format but need not be converted when used in Petrolog). 
These files can be structured like the LAS format or non structured including wrapped 
files, comma delimited etc.  

• DLIS: A POSC compliant format for data interchange 

• LIS: A POSC compliant format for data interchange. Encapsulated LIS files on disk 
normally have the .TAP  extension. 

• LAS: A POSC compliant ASCII format for data interchange. LAS 1.2, 2.0 and 3.0 
standards are supported by Petrolog. 

• LBS: The Schlumberger Log binary format for data interchange. A combination of LAS 
header data and binary log data. However, this format is not common used. 

• SEGY: A POSC compliant format for data interchange of seismic data. 
• Windows compatible files:.doc, .xls , .xml, etc. These files need to be converted to either 

an ASCII format for direct import into the continuous log data or into an excel format table 
for copy and paste into the Petrolog discrete data system. 

Graphics Format Files 

tiff, .jpeg, bnp, .cmg, .pcx and other graphical format files. These can be pixel, vector or a mixture 
of the two format files. These files are for display purpose only and cannot be used for processing 
data but can be imported in the Petrolog montage editor. 

Petrolog Internal Format Files 

Petrolog uses an internal binary format file to store continuous log data (array or single curve 
logs) and a various array of xml files to store other pertinent information. All the file related to a 
well will start with the same file name (usually the name of the well being processed) with an 
extension to identify the file type and content. 

Some of the extensions used by Petrolog are: 

• .logdata: A binary format file containing the well continuous log data. This includes 
array logs, single curve logs etc. The can be time or depth based file with unlimited length 
and depth increment and unlimited number of columns. This file type is equivalent to the 
Petrolog V9 .DAT file 

• .logheader: An XML format file that contains additional information about the content the 
matching .logdata file like (Long log name, process status, tool origin, statistical 
information etc.) 
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• .welheader: An XML format file that contains the well header, strata and discrete data. 
This includes the general well header information, the field remarks, all the different 
logging run information (unlimited number of runs), formation tops and any well discrete 
or "static" data. This file type is equivalent to the Petrolog V9 .HED file. 

• -pro.logdata: A binary format file contains the processed results from the matching 
.logdata  file. All the logs from the .logdata files are copied initially across and 
environmentally corrected as per user instructions. This file type is equivalent to the 
Petrolog V9 .PRO file. 

• .logaudit.txt: This is a text file that contains the history (audit) of most of the main 
operations affecting the logs. (Date created, where logs were loaded from, shift and 
merge functions etc.). This file type is equivalent to the Petrolog V9 .ATF file type. 

• .procon: An XML file containing the zone control file parameters used in the log analysis 
module. It can contain an unlimited number of zones each with different parameter sets. 
There are currently over 300 zone parameters that can be modified for each zone. See 
Modify Control Parameters for additional informations. This file type is equivalent to the 
Petrolog V9 .CON file type. 

• .plot: XML files containing the plot configurations including track information, curve 
information, VDL displays etc. The plot file is also used as a control file to process 
formation images. (FMS, FMI, EMI, STAR etc). The plots can be sent to printers, plotters 
or files (.emf, .pdf etc.). This file type is equivalent to the Petrolog V9 .Pxx file type 

• .strata: An XML file containing the default strata settings (names, strata marker line 
style, colour and lithology shadings). All wells are linked to a defaults.strata file to provide 
the master list of stratas that can be defined in each well. This file type is equivalent to 
the Petrolog V9 .FFD file. 

• . .emf: A Windows format graphics file. Petrolog generates emf files as its native 
format output. 

• .montage: An XML file that defines a Petrolog montage. A montage consists of a 
background .emf file with other graphics objects (e.g. other emfs) inserted. This file type 
is equivalent to the Petrolog V9 .MAC macro file. 
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First Time Users 

Petrolog is a project oriented software and it is highly recommended to set the well data files in 

clearly defined directories for easy access. 

There are too many features available to cover everything in a step by step procedure. However, 
this section can guide a new user on what to do in the correct sequence to start a log analysis. 
For more details on the full capabilities of Petrolog the Help system should be used consistently 

to learn the tricks of the trade.  

Another option to get start using Petrolog is to work through the Petrolog Tutorials. These 

tutorials are the same ones used in our Basic Training School. 

Step By Step Procedures 

1. Using Windows Explorer, create a directory under which all well log data files will be 
stored. (e.g. PROJECTS or WELL LOGS) 
 
This directory can be on any drive on any network provided the network drive is properly 
mapped. (e.g. drive G: in the UK, Drive H: in Houston etc.). Data processing via network 
drive will slow down operations depending on the network traffic and network speed. A 
network working at 100 megabit/second network will still be substantially slower than 
processing from the local disk drive.  

2. Under PROJECTS, create a logical directory structure drilling down to separate 
directories for each well. For example, a suitable structure may be: 

PROJECTS > 
  COUNTRY > 
     FIELD > 
         WELL-A 
         WELL-B. 

3. Copy the log data files to import from (LIS, LAS, DLIS) into the appropriate well directory. 
This also applies to the old versions of Petrolog files with the extensions .DAT, .HED, 
.CON which were previously saved in the same directory should be copied to the 
individual well directories. 

4. Click on the  icon to start Petrolog. If you are evaluating Petrolog, see Evaluation 
License to apply for a 60 day evaluation license. 

5. Set your preferences: See Preferences Overview for further details. 

6. See Project Explorer  and use  Browse Project to set your default start point. As 
shown in figure 1, preferably set the project root at the highest "level" that you will be 
working in (here all directories under projects will be opened) 

7. Select a .logdata file if you have any available (identified by the blue icon ) to open this 

well. 
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Figure 1: Project Directory Layout and Active Well Selection 

8. Right mouse click on a input data file (eg LAS, LIS or DLIS and select import to create a 
Petrolog .logdata file for this well. See LAS , LBS, ASCII, LIS, DLIS) 

9. If you have copied the old Petrolog format files and need to convert them to the new 
Petrolog formats (those with the extensions .DAT, .CON. .HED). See Petrolog V9 
Conversion 

10. Edit the well header file: See Edit Well Header 
11. Add the formation names. See Edit Strata Data 
12. Edit the .logdata file to check the long log names, units etc. See Modify Log Details 
13. Create a composite log: See Create Log Plot 
14. Edit/merge logs as per the help files for Continuous Logs, Merge Logs, Edit Logs, 

Function Logs 
15. Perform any graphical editing (Depth matching, log patching, Baseline shifts etc) See 

Depth Matching, Log Patching, Baseline Shift 
16. You are now ready to start the formal log analysis. See Petrophysics 
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Tutorials 

Petrolog Tutorials Overview 

Welcome to the Petrolog tutorials. 

These tutorials are designed both for new users of Petrolog. The various tutorial topics will take 
you from the basics of using the Petrolog desktop through importing, editing and petrophysical 

evaluation of various types of well log data. 

The major descriptions and help reference for the Petrolog functionality can be found in the main 
help topics, with context sensitive help available by pressing F1 at any time. These tutorials are 
designed as a step-by-step overview on performing various tasks utilising supplied tutorial log 
data. The corresponding help file and tutorial topics will have links to each other. 

As Petrolog is rapidly evolving with new features and functionality, the tutorials may not be 
completely up to date with the latest features and improvements. Each new release will include 
an update of the tutorials and will highlight new features introduced to the software. 

These Tutorials are also the practical exercises given during our formal Petrolog Training 
Courses and offer a "self teaching" option if attending is not possible. For more information, 
please refer to www.petrolog.net for details on Training Course dates and content. 

In addition to the specific tutorials below, a summary of the various logging tools and their basic 
interpretation is available in the Logging Tools tutorial. 

Basic Training Module Tutorials 

• Tutorial 1: Getting Started 

• Tutorial 2: Import/Export 

• Tutorial 3: Editing and Basic Graphics 

• Tutorial 4: Advanced Composite Logs 

Petrophysics Training Module Tutorials (available when I finally get some 
time to write them up!) 

The following data sets are included in the Tutorial Examples download under the AUSTRALIA > 
WA > EXAMPLES folder. These examples are used during our Petrophysics Training School and 

Tutorial instructions will be available in this help file for them in the near future. 

• Tutorial 5: Digital Sonic Processing using the DSI_RAW data set. 

• Tutorial 6: Quicklook Log Analysis using the Quicklook Petrophysics User Algorithms on 
the DEMO well 

• Tutorial 7: CPX Petrophysics (including Neural Network log prediction, Facies processing 
and HVR using the DEMO well) 

• Tutorial 8: CPX Petrophysics (including multiwell processing) using the RAMBO wells 

• Tutorial 9: Nuclear Magnetic Resonance (NMR) Petrophysics using the NMR well 

• Tutorial 10: Thermal Decay Time (TDT) Petrophysics using the TDT well 

• Tutorial 11: Coal Bed Methane (CBM) Petrophysics using the CBM well 

• Tutorial 12: Neural Network Analysis with Core Porosity & Permeability using the 
NEURAL_CORE well 
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• Tutorial 13: Synthetics Processing using the SYNTHETICS well. 

• Tutorial 14: Introduction to Imagelog Processing. 

Tutorial Data 

The tutorial data is available from the installation CD or as a download from the Petrolog website 
at www.petrolog net/downloads. The required zip file is Petrolog10.x_tutorial_examples.zip. The 
tutorial data set consists all required well data to use in the Petrolog Tutorials. 

Further details on setting up the tutorial data for use is given in Tutorial 1 under  Exercise 1.1: 
Getting Started 
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Release Notes 

Petrolog 10.5 

10.5.0 build date: 31-Mar-08 

10.5.1 build date: 16-May-08 

During the installation of Petrolog 10.5.1 on a client computers, we discovered that Petrolog 
intermittently crashes on startup on some networked PC's. This was tracked down to a bug in the 
.NET 2.0 framework when a splash screen is displayed on a standalone thread during program 
initialisation. We have now disabled the splash screen on startup. 

10.5.2 build date: 22-May-08 

Updates included in Petrolog 10.5.1 release 

After the 10.5.0 release, we continued with further incremental development and bug fixes on a 
wide range of Petrolog applications including the following: 

• Plotting enhancements: Improvements to overview track, TVD indexed plot handling, 
improved dip tadpole colour/symbol options. 

• Plot graphic file printing: Added EMF file/page sizing options and improved the 
generation of very large Imagelog EMF files (size now limited by operating system and 
PC memory constraints). 

• TVD Processing: Improvements to Petrolog processed TVD results when compared to 
processed results from DD service providers. 

• Petrophysics enhancements: HVR now has Geometric Permeability and further 
processing and display improvements to the CPX interface. The recomputed density log 
RHOBC generated from the SSS model is also improved. 

• Digital Sonic Processing: Transmitter Array and Vp/Vs guided shear semblance, post-
processing options (Mechpro, Transit Time and Averaging). The Shear Anisotropy 
module (with Alford Rotation and Tang-Chunduru full inversion functionality) is now 
complete. 

• Mapview: 3D kriging points for contouring, contouring of CPX parameters, well path 
colour options, graphics file display at well locations and various interface improvements 
and display options added. 

• Cross-Section: Further additions to new Cross-Section module. Still under development 
for a final release in Petrolog 10.6. 

Major Enhancements implemented in Petrolog 10.5.0 

• Environment: Improved the preferred units system, hybrid units (e.g. Canadian) now 
applies to all graphics and CPX functionality 

• LAS Import/Export: Merged the LAS, ASCII and Petrolog V9 Import into a single dialog, 
with extensive workflow efficiency enhancements and options added. 

• Petrolog Explorer: Added a well filter using file name, wellheader field and log 
availability search criteria. 

• Continuous Data: Logdata file read/write access upgraded to allow only one write 
process to access the logdata file 
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• Continuous Data: Majority of dialogs & processing now "modeless" allowing continued 
interactivity during processing. 

• Plots: Can now display any log from multiple files/wells on same plot, plus many other 
enhancements including "scroll locking" between plots. 

• Plots: Improved stability printing very large graphics files outputs to EMF and XPS 
formats and downscaling of graphics images to display/print resolution. 

• Histograms: Can be used to generate Normalised Log outputs and statistics reports 
from data/intervals displayed on Histogram 

• Crossplots: Extensive improvements including improved multiwell display, ghost 
background mode and additional display options. 

• Petrophysics: Multiwell CPX crossplots now fully operational, with intuitive formation 
selection logic when changing between wells. 

• Petrophysics: Extensive updates to the Hydrocarbon Volume Reporting module. 

• Cross-Section: New module with full directional well paths and fully interactive objects 
(wells, strata, faults, etc). Still under final cleanup for formal release in 10.5.1 update. 

• Mapview: Now displays well directional paths, plus many additional display options 

• Digital Sonic Processing: Added AGC corrections, Flexural Dispersion and Sonic 
Anisotrophy Processing to module, plus additional tool definitions. 

• Datalogger: Added auto-remarks plus additional depth encoder support to the FET 
datalogger software. 

Detailed List of Petrolog 10.5 updates 

Environment 

• NEW FEATURE: Units: Clean up Unit Preferences, custom (Canadian) units available for all graphics and CPX 

• Enhancement: Statistics: Add recompute statistics option (with adjustable sample %) under File Maintenance 

menu 

• Enhancement: Installation: Auto install either the 32 or 64 bit Sentinel library 

• Enhancement: Multiuser Sentinel: Add link to browser monitor, improve release of multiuser modules 

• Enhancement: Calculator: Add scroll bars if too long, other cleanups? 

• Enhancement: Preferences Image Resolution now has "Screen" or "Printer" options 

• Enhancement: Preferences: Add option to prevent GDI deleting large Image EMF files during creation 

• Enhancement: Images (Discrete Data,,Annotations,,Montage): downscaled to match current screen/print 

resolution 

• Enhancement: XPS: Fixes to output plots to Microsoft XPS print driver (logos, images, remarks, tadpoles etc). 

• Enhancement: Change the Petrolog symbols to "EMF" only format (Excel 2003 has problems with EMF+). 

• Defect Fix: EMF: Various crashes/issues with very large Image files, now limited by Windows constraints. 

• Defect Fix: Statistics: Not performing statistics update on small files held in cache correctly 

• Defect Fix: Startup splash screen: Was intermittently crashing on a client PC due to a .NET 2.0 issue. Now 

disabled. [10.5.2] 

• Enhancement: LAS certify now has a quiet installation, pops open graphical interface first time run. [10.5.2] 

Import/Export 

• NEW FEATURE: Consolidated ASCII and Petrolog V9 Import/Export in common dialog, now allows multiwell, 

strata, XLGS functionality 

• Enhancement: Updated LAS Certify to latest version (supports 1.2, 2.0 and 3.0) 

• Enhancement: LAS3: Handle non-standard section headings with trailing text after keyword, e.g. "~VERSION 

INFO" 

• Enhancement: LAS Export: Add Ability to select the "CPX" keyed input logs in the xlgs output specification 

• Enhancement: LAS Export: Add ability to apply Export Filter to all wells selected in multiwell export  

• Enhancement: LAS Import/Export: Add ability to create and Import/Export directly to well folders 

• Enhancement: Export LAS: Add option to strip white space from lognames (e.g. "K    -CPX" -> "K-CPX"). 
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• Enhancement: Import LAS: Select/correct log names/units while importing LAS,ASCII via XLGS files (can in V9) 

• Enhancement: Import ASCII: Autodetects mnemonics, units and first data row 

• Defect Fix: DLIS/LIS: xlgs export selects incorrect log column when only 1 logdata file being exported 

• Defect Fix: ASCII Import with Group title in wrong log column if blank logs existed at end of file 

• Defect Fix: LAS 2 Import crashing if LAS data had zero index increment value 

• Defect Fix: Export LAS: Multiwell exporting by Strata used the last well depth range only. 

• Defect Fix: Petrolog crashed on pre v9.5 .DAT file conversion (post 9.5 .DAT files ok). 

• Defect Fix: Import LAS: Incorrect rounding to nearest sample when sample depth midpoint of increment. 

• Defect Fix: Export LIS: Log values that were exact powers of 2 were set to 0 on LIS export [10.5.1] 

• Enhancement: Added the LAS Certify Utillity into the Petrolog install [10.5.1] 

• Defect Fix: Export LAS/ASCII now uses selected depth unit (m or ft) instead of the program default unit[10.5.1] 

Explorer/Project 

• NEW FEATURE: Well Filter: Further options to filter by file name, log existence, wellheader fields. 

• Enhancement: Add Save/Load/Reset options to Well Filter. 

• Enhancement: Reduce the number of refreshes for Explorer and Log Listing windows 

• Enhancement: Data Mining: Quick Histogram functionality added to Data Mining 

• Enhancement: Can now rename files to same name in different cases. 

• Enhancement: Filter: Need to also remember previous Filter Folder setting on exit and reopen. 

• Defect Fix: Filter: Not saving well paths correctly due to build obfuscation, crash on invalid directories [10.5.1] 

• Enhancement: Selected Well: Need to make currently selected well (logdata) file more prominent [10.5.1] 

Discrete Data 

• Enhancement: DD tables: Add the "Sort by" columns functionality (as per the Log Name Defaults table) 

• Enhancement: Multiwell Strata: Improve Multiwell Strata dialog to allow cut and paste from spreadsheet! 

• Enhancement: When drag & drop tracks with Discrete Data, plot display of data is now left on. 

• Enhancement: DD Tables: Prevent non-numeric entry in Int/Real fields, was causing validation lockups 

• Enhancement: Strata: Now converts and displays correctly on TVD display plots 

• Enhancement: Improved resizing logic for DD text tables (once on open, vertical only on data entry) 

• Enhancement: Text copy & paste: Improvements to handle line break from Excel to Petrolog 

• Enhancement: Header/Discrete: Set decimal place for numeric data via preferences, cleanup header defaults 

• Enhancement: Discrete Images: Display only at required resolution, width scaling issue with XPS 

• Enhancement: Discrete Data: Works correctly with all track copy, paste, insert delete, ect 

• Defect Fix: Continuous to Discrete, Discrete to Continuous: Move valid depth range checks to OK rather then 

depth entry  

• Defect Fix: Discrete Plotting: Disable on version upgrade, multiple lithology linkages becoming "locked" 

Continuous Data 

• NEW FEATURE: Logdata read/write access overhauled to allow one read-write application at a time 

• NEW FEATURE: Majority of processing now "modeless" allowing full user interactivity during processing  

• Enhancement: Datafile modify/append references: now changed to non static method for improved stability 

• Enhancement: Statistics: Log Statistics only recomputed 5% on sample (controlled by user settings) 

• Enhancement: Statistics: Add recompute statistics option under File Maintenance menu 

• Enhancement: Modify Log Data: Add right click function to append prefix or suffix to log name or description 

• Enhancement: Edit Log Data: Add a "Search & Replace" type function to the prepend/postpend function 

• Enhancement: ToUpper/ToLower: All legacy file case conversions should use String Compare instead. 

• Enhancement: Append text to Logname, Log Description now includes a keyword [LOGNAME] option 

• Enhancement: Shift Logs Vertical: File size not changed, log data can be lost from top or bottom of file 

• Enhancement: Log Data Listing Dialog has updated layout and buttons. 

• Enhancement: Scroll Lock: Lock the View Log Display to plots option added. 
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• Enhancement: View log data: Filter data should also filter out missing. 

• Defect Fix: Statistics: Incorrect Statistics set by User Algs during destination log creation. 

• Defect Fix: View and edit display filled with 0.0 (underlying file ok) after interpolation functions run 

• Defect Fix: Reindex: Decimating a logdata file with average sampling caused exception 

• Defect Fix: Append log columns had problems when # of data columns > # data records 

• Defect Fix: General: Need to delete/copy or move all _temp files as where perform same action on logdata 

• Defect Fix: Datafile: Auxillary filenames being case converted, should ALWAYS be same as datafile name 

• Defect Fix: Manual Interpolate: Very slow, multiple reads of same file when doing multiple logs 

• Defect Fix: Extending data file would sometimes move buffered logdata to wrong log column 

• Defect Fix: Manual Log Merging: Fixed bug on not closing data files correctly when finished. 

• Defect Fix: View Logs: Select Arrays with Collapse Arrays selected, then unselect double # of array cols. 

• Defect Fix: View Log Data: With display without missing v slow, and rescans every time display refreshed. 

• Enhancement: Graphical Merging: Should display all curves in preferred units, output in preferred unit if new log 

[10.5.1] 

• Defect Fix: Graphical Merging: Unit conversion to destination incorrect with mixed unit input logs  (US/M -> 

US/M gets a 3.281 gain) [10.5.1] 

• Defect Fix: Edit Log Data: Was crashing when all logs deleted from logdata file [10.5.1] 

Functions: 

• TVD Processor: TVD computation now more accurately reproduces industry standard results [10.5.1] 

Graphics: Plots 

• NEW FEATURE: General: Allow curves from multiple .logdata file on single plot 

• NEW FEATURE: Scroll Locking: Allow user to "scroll lock" plots together 

• NEW FEATURE: Print to EMF: Add Options Dialog to scale, set DPI, choose output format, etc [10.5.1] 

• Enhancement: Apply buttons: Add apply buttons to Tracks, Depth, Curve, Shading, Depth Label dialogs 

• Enhancement: Right Click option: Add change log headers to compressed option 

• Enhancement: Display 6" sampled logs at 1:10 or higher has some smoothing problems 

• Enhancement: Curves: Implement autoscale logic to unknown logs when curves changed via Edit Curve dialog 

• Enhancement: Track Titles: Need to reverse/disable track title layout in lower curve header block in plots 

• Enhancement: Autoscrolls when up/down arrow held down  

• Enhancement: Shading: Implement the transparent "Modifier" Lithology in continuous log shading 

• Enhancement: Plot Fonts: Uses local copy during print to avoid plot size reductions in other open plots 

• Enhancement: Multifile: Log based shading (eg Mineral, Hydrocarbon, Lithology) to use external logs 

• Enhancement: Secondary Depth Labels: Continue to print depth with Deviation > 90 degrees 

• Enhancement: Depth Labels: Secondary depth columns not updated in plot if datafile columns updated 

• Enhancement: Plot: Add option to display a watermark text string on each page of plot 

• Enhancement: Plot Components: Update Selected Symbols component to read DD & Annotation symbols 

• Enhancement: Plot Defaults: Add symbol type function to Log Plot Defaults (eg core data, etc) 

• Enhancement: Plot Preferences: Local copies of preferences (font, dip, etc) now available in plot template 

• Enhancement: Plot Shading was missing on top and bottom samples of zone in zoomed in mode 

• Enhancement: Units: Add flag in templates to use either preferred unit/scale or use defined unit/scale only 

• Enhancement: Curve Drag & Drop: Used preferred unit/scale instead of log unit. 

• Enhancement: Add a "Add to previous curve" tickbox in the right click modify curve dialog 

• Enhancement: Right click options: Add copy & paste curve (similar to copy and paste track) 

• Enhancement: Tracks: Save/load the Track Grids settings from templates.  

• Enhancement: Add/Remove image files in Plot Components improved in Datalogger/Petrolog models 

• Enhancement: Clipboard Editor: The save as default (emf, emf+, emfdual) should be read from preferences 

• Enhancement: Add a Cancel option to the update plot xml messagebox 

• Enhancement: Plot file editors now switch the depth index back to column 0 to allow editing (display strata in 

TVD?) 

• Enhancement: Print: Added a Right Margin setting to Print dialog 
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• Enhancement: External Curves: Add copy individual curves functionality (only full tracks atm) 

• Defect Fix: Some datafile hanging references on closed plots, causes crash on processing datafile 

• Defect Fix: Lithology Sidebar was losing its lithologies when switching between plots. 

• Defect Fix: Tracks Dialog: Make changes, click apply, then exit applies changes twice. 

• Defect Fix: External Curves create datafile handle for each curve, not closing properly, needs Testing. 

• Defect Fix: Scrolling/Print: Lines appearing random across plot, some text being truncated. 

• Defect Fix: External Curves: Ishy has example where external curves/shading not continuous on XPS 

• Enhancement: Annotation Editor: Move to single toolbar, integrate object properties into single menu [10.5.1] 

• Scroll Speed:  Eddies suggestions 22/3/08 (bitmap copy, paging system), improve scroll speed approx 5% 

[10.5.1] 

• Overview track: displays formation tops and colour bands! [10.5.1] 

• Now refreshes curve header track thickness when user resizes tracks. [10.5.1] 

• Add right click option to remove shadings. [10.5.1] 

• Changed text fonts in all plot templates to Arial (was mixture Arial, Times and Courier) [10.5.1] 

• Symbols: Add ability to change colour of EMF symbols, colour options in annotator working? [10.5.1] 

• Defect Fix: TVD indexed plots: Add to curves display not working correctly (multiple copies of curves). [10.5.1] 

• Defect Fix: External Curves: When external datafile updated, external curves/shadings from -pro file dropped. 

[10.5.1] 

• Defect Fix: Annotator: doesn't switch back correctly if working with non-0 depth column and SS offset [10.5.1] 

• Defect Fix: Graphical Strata Editor: doesn't switch back to correct depth when using TVD and offset reference. 

[10.5.1]. 

• Defect Fix: Petrolog v9 template conversions, several bugs fixed while updating a large set of client DRA files 

[10.5.2]. 

• Enhancement: Added a set of "Geological Facies" to the Lithology defaults [10.5.2] 

Graphics: Histograms 

• NEW FEATURE: Log Normalisation Function: Generate a normalised log output from Histogram stats 

• NEW FEATURE: Log Reporting: Add link to data mining to generate report with displayed Histogram stats 

• Enhancement: Switch between All or combined cumulative curves 

• Enhancement: Now able to save/load log axis settings to preferences 

• Enhancement: Depth interval title when printing to emf uses the preferences depth unit (M or FT) 

• Enhancement: If specific name n/a in well, find generic log (plus options in Log Listing) 

• Enhancement: Allow data filtering in Multiwell mode (only worked for single wells previously) 

• Enhancement: Drag & Drop onto histogram now displays in Preferred Units (not log units) 

• Enhancement: Alternate Unit display now fully functional in multiwell mode 

Graphics: Crossplots 

• NEW FEATURE: Add a ghost "crossplot screenshot" mode to show previous/next zone/facies/well 

• Enhancement: Allow data filtering in Multiwell mode (only works for single wells atm) 

• Enhancement: If specific name n/a in well, find aliased generic log (plus options in Log Listing) 

• Enhancement: Log Scaling now works correctly in all cases for Multiwell displays 

• Enhancement: Drag and drop from any file rather than primary file only 

• Enhancement: Skip Missing: Add a raw log field in Crossplot Log Defaults, used to skip empty in CPX/MM 

• Enhancement: CPX: Pink highlighted points were being are overdrawn by standard points on refresh 

• Enhancement: 2D: Can now display crossplot with plain colour (no z-axis value) 

• Enhancement: Moveable points on crossplot polygons for resizing (activate by right click) 

• Enhancement: Shapes: Merge Move/Properties. Move left click, properties + delete right click menu 

• Enhancement: Multiwell: Allow use of z-axis colour ranges in addition to the current well colour only 

• Enhancement: Can now switch CPX and MM crossplot manually to alternate unit, grids, overlays, regions work 

correctly 

• Enhancement: Axis Values now have improved display of significant figures 

• Enhancement: Units: Reload Crossplot log defaults from xml instead of cached version when switching  

• Enhancement: Units: CPX Crossplot and side plot to use CPX Opunit 
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• Enhancement: Units: General crossplots dropdown and drag & drop to use preferred unit 

• Enhancement: Multiwell Names: Add button to turn multiwell names (top left corner) on/off. 

• Enhancement: Reporting Crossplots: Ability to add/modify regression lines now included. 

• Defect Fix: CPX Crossplots: If points outside plot when highlight in track to flag, not included 

• Defect Fix: Crossplots were exceptioning if log drag and drop repeated before previous redraw finished 

• Defect Fix: Print to EMF: Sidebar plot had fixed curve header block, now variable and plots to base of page 

• Defect Fix: VRML 3D: Fixed crashed when generating VRML with input logs missing 

• Defect Fix: CPX + MM Crossplots: Fixed crash after user prompted to create control file 

• Defect Fix: Crossplot Flagging: Disable user controls when setting flag values to avoid multiple instances 

• Defect Fix: Crossplots: Logarithmic Grid Overlay not correct for scales other than 1E? Endpoints 

• Defect Fix: Crossplots: Unrecognised unit box was crashing crossplots during redraw 

• Defect Fix: Fixed bug where regioning of points didn't work correctly when using Secondary Scale 

Petrophysics 

• NEW FEATURE: Multiwell: Add Multiwell CPX crossplot, plus skip missing formation button  

• Enhancement: CPX/HVR: Improved options including High/Low Cutoff Net and Pay Flags 

• Enhancement: CPX: GR asymmetric/50% Stieber points renormalised when GRMIN, GRMAX changed 

• Enhancement: CPX: Add a zone lithology modifier to overlay on CPX results plots 

• Enhancement: CPX: Improved SSS logic to compute VSND,VSILT with clean points RHOB > RHOclay 

• Enhancement: Multiwell Crossplots: Improved the formation selection logic 

• Enhancement: CPX: Add the SSS mode "Calcite Flag" option for displayed non-clastic beds 

• Enhancement: HVR: Change output cutoffs to display in % rather than V/V and other report cleanups 

• Enhancement: HVR Net/Pay text outputs missing if 0 interval 

• Enhancement: HVR: Add conditional log options for Net Reservoir/Pay P10,P50,P90 cutoffs 

• Enhancement: HVR: Add a Minimum Included Thickness to work in all modes and both Pay & Net 

• Enhancement: CPX: Now limit PHIA to PHIMAX, also include a PHIMAX point on crossplot 8 (PHIA vs RWA) 

• Enhancement: CPX: Allow recreate of processed file from within Crossplots 

• Enhancement: Cased Hole: Added Open Hole computed Sigma to processing. 

• Defect Fix: CPX Units: Not working correctly when RHOB in kg/m3 and caliper missing 

• Defect Fix: CPX: Threading error when running ENV+CPX from crossplots fixed [10.5.1] 

• Enhancement: CPX+Multi: Facies zones should be coloured as per FACIES flag colour [10.5.1] 

• Enhancement: HVR: Add Mean/Geometric Permeabiltiy (with sd) and Perm-Height calculation [10.5.1] 

• Enhancement: HVR: Added a TVDSS reporting option (now has MD, TVD, TVDSS and TST) [10.5.1] 

• Defect Fix: CPX: The incorrect run parameters (BS, mud, etc) can be imported in procon if TLI missing [10.5.1] 

• Enhancement: CPX: Add a compute button to the CPX Control File Edit dialog, updates edited zones [10.5.1] 

• Enhancement: Special Mineral: Add a compute button inside Special Mineral Dialog [10.5.1] 

• Defect Fix: CPX: The recomputed RHOBC too high in Silts, spikes in high Vclay transitions [10.5.1] 

• Enhancement: Multiwell CPX: Add selectable zone name processing option [10.5.1]. 

• Enhancement: HVR: Now showing wellname and UWI (instead of filename) in summary report. 

• Defect Fix: CPX: Non-linear Vclay not being computed with one Vclay input or the weighted averages option. 

Neural Network 

• Enhancement: Also add the postpend text option to the NN Processor folder save set 

• Defect Fix: Neural: FileAccess error when open folder with same Training & Prediction file or Statistics report. 

Cross-Section 

• NEW FEATURE: Port existing Cross-Section functionality to a new Interface 

• NEW FEATURE: Display of directional/horizontal wells 

• NEW FEATURE: Interactivity: Strata surfaces (move/add/delete/text edit) 

• NEW FEATURE: Interactivity: Faults & Pinchouts (move/add/delete/displace) 
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• NEW FEATURE: Interactivity: Wells (move/add/delete, depth range, plot, plot width?) 

• Enhancement: Required updates to switch between MD and TVD display wells  

• Enhancement: Drag & drop well (add, remove, change order) after generated by explorer/mapview 

• Enhancement: Switch between well plot template and well stick display modes  

• Enhancement: Additional interwell colour options (1-log range, 3-log RGB) 

Mapview 

• NEW FEATURE: Added top down well path display to Mapview ("Birds eye view") 

• Enhancement: Added statistic type to info text on map, fixed bug with map info file path 

• Enhancement: Bubble Maps: Add colour control, improved legend 

• Enhancement: Contouring: Histogram of variogram, be able to change #/colour range of contour levels 

• Enhancement: Added colour ranges to birds eye view, well name to end of path, other various improvements 

• Enhancement: Implement/improve Zoom and Home functionality (should redraw map) 

• Defect Fix: Mapview was crashing if map is at root level of explorer 

• Defect Fix: Unable to add background map to mapview, gives file path name error. 

• Enhancement: Well Path: Colour of well path, to match the Cross-Section options [10.5.1] 

• Enhancement: Implement x,y,z kriging points and well locations (with top, bottom, mid interval intersections) 
[10.5.1] 

• Enhancement: Contour: Also allow contouring of CPX control parameters (eg RW, m, etc) [10.5.1] 

• Enhancement: Well Selection: Drawing select well box should have some intellegent sequencing.[10.5.1] 

• Enhancement: Add ability to display an emf for each well (eg Stereonets) [10.5.1] 

• Defect Fix: Print to emf has issues with map, font scaling (eg Rambo Nullara map!) [10.5.1] 

• Defect Fix: Need to save/load background map settings as map loaded/unloaded [10.5.1] 

• Enhancement: Add log name alias option to Log Listing for Mapview [10.5.2] 

Imagelog 

• Enhancement: Accelerometer corrections: Stops 1 filter length at top of data, V9 handles with reduced filter 

• Enhancement: Destriping corrections: Stops 1 filter length at bottom of interval, v9 handles with reduced filter 

• Enhancement: Petrolog now not locked during processing, uses modeless dialogs. 

• Enhancement: Export: Add option to generate the HLS EMI/XRMI EMIP and CLAZ caliper/azimuth array  

• Enhancement: Autodip: Autolink to DIPI, Apply button, processing select reference button, dip overwrite option 

• Enhancement: Arm Swing Corrections: Add logic to avoid interpolation of large missing gaps 

• Defect Fix: Creating new tadpole plot column now doesn't copy any previously defined tadpole data in plot 

• Defect Fix: Stereonet Plot: Azimuth Rose plot showing all status, not selected status. 

• Enhancement: Autodip: Added a Mirror Image Dip Filter option [10.5.1]  

• Enhancement: Tadpoles: Add ability to change colour of any available EMF symbols [10.5.1] 

• Enhancement: Tadpoles: Be able to display status by color AND symbol (can only do one or the other atm) 

[10.5.1] 

Digital Sonic Processing 

• NEW FEATURE: Added AGC processing (and test/finalise ISONIC processing) 

• NEW FEATURE: Added Flexural Wave Dispersion correction processing 

• NEW FEATURE: Added Sonic Anisotropy (fast & slow dipole shear) processing [10.5.1] 

• NEW FEATURE: Transmitter Array DT processing [10.5.1] 

• Enhancement: Add Vp/Vs guided shear processing option [10.5.1]. 

• Enhancement: Post-processing modules (Mechanical Properties, Transit Times, DT Averaging options) [10.5.1] 

• Enhancement: Added MSIP "hires" processing modes using 3 sets of 5 receivers. 

Datalogger 
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• NEW FEATURE: FETLogger: Added a playback autoremark feature for FET plots 

• NEW FEATURE: FETLogger: Added support for the CNLC depth encoder system 

• Enhancement: DSPLogger: Updated to latest schema, file access methods and tested 

 


